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Minimal-level cataloging guidelines 
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Background 
In February 2011, the American Museum of Natural History (AMNH) began two grant-funded efforts to create catalog records 
and collect risk assessment data for library and archive collections under the Museum’s Science divisions.  The projects have 
been funded by the Council on Library and Information Resources (CLIR) and the Institute of Museum and Library Services 
(IMLS). 
 
The CLIR-funded Cataloging Hidden Collections project will produce nearly 1,400 catalog records from data that has been 
gathered in a systematic fashion for four major archival groups held in the AMNH Research Library: 

 Manuscript collections (MSS) 

 Department records (DR) 

 Photographic prints (PPC) 

 Photographic slides (PSC) 
 
Project Archivist Iris Lee manages teams of interns to create catalog records for the collections and develops a process for 
converting and batch-loading Machine-Readable Catalog (MARC) records from spreadsheets.  Finding aids for 20 collections will 
also be created and made available online in Encoded Archival Description (EAD). 
 
The IMLS-funded Science Department Archives and Library Risk Assessment project is the third phase of a comprehensive 
Museum-wide risk assessment program.  In its first year of funding, this project analyzed the risks for the specimen and artifact 
collections in the Science Departments and, in its second year, the risks for the science collections on permanent exhibit.  In this 
third phase, Becca Morgan, Project Archivist, manages teams of interns to create catalog records for the archives in the Science 
Departments and gather risk assessment data for both libraries and archives under Science: 

 Anthropology 

 Conservation 

 Earth and Planetary Sciences 

 Herpetology 

 Ichthyology 

 Invertebrate Zoology, Entomology 

 Invertebrate Paleontology 

 Mammalogy 

 Ornithology 

 Paleontology 

 Registrar 

 Research Library 
 
The same cataloging process proposed for the Library Cataloging Hidden Collections (CLIR) grant was proposed, and is being 
used for the initial data gathering for the Science Department Risk Assessment (IMLS) grant resulting in minimal catalog records 
for those collections as well.  Project Archivist Becca Morgan manages teams of interns in cataloging and assessing risk to 
archival collections in the Science Departments.   
 
Though the projects are managed discretely, the process of gathering data is co-managed by the two project archivists.  Student 
interns work in teams of two to gather the descriptive data and the data to be used for the risk assessment. 
 
When the projects are completed: 

 Any textual and photographic archive collections held in the AMNH, whether in the Science Department Archives or 
the Research Library, will be found by searching the Library Catalog, the OCLC bibliographic network (WorldCat) or by 
directly searching the web; in addition, records for Field Notebooks in the AMNH Archives, again regardless of 
location, may be added to the Field Book Registry presently being developed and hosted by Smithsonian Institution 
Archives. 

 Risks will be assessed for all the archival collections, in the Science Departments and in the Research Library, finalizing 
the comprehensive Museum-wide risk assessment. 
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Creating minimal level catalog records 
We are cataloging a large number of archival collections museum-wide, sometimes over hundreds in a single location.  To 
record them all in a strategic and efficient manner, interns work in teams of two gathering data in Excel spreadsheets with data 
fields mapped to MARC fields.  Our goal is to create minimal-level catalog records to provide a single point of access for all the 
archival collections in the Museum through the Library online catalog, OCLC and, ultimately, on the web. 
 
Describing Archives: a Content Standard (DACS) defines a single-level minimum record as having the following: 

 Reference Code Element (2.1) i.e., Call number 

 Name and Location of Repository Element (2.2) 

 Title Element (2.3) 

 Date Element (2.4) 

 Extent Element (2.5) 

 Name of Creator(s) Element (2.6) 

 Scope and Content Element (3.1) 

 Conditions Governing Access Element (4.1) 

 Language and Scripts of the Material Element (4.5) 
 
Additional data fields are available in the spreadsheet, but they are not required.  A fuller description will facilitate better 
discovery, but please keep in mind that we want to meet our goals for the projects and not get too lost in the details.  However 
recording additional access points (e.g., subjects and contributors) is highly encouraged especially if they are easily identified.  
 

How do these spreadsheet records become MARC records? 
The spreadsheet information is batch-converted into MARC records using an open-source program, MarcEdit, then uploaded to 
OCLC and Innovative Millenium using OCLC Connexion.  MARC records are also imported into Archivists’ Toolkit where they can 
be exported as EAD-encoded finding aids.  Once the catalog records are in Archivists’ Toolkit they can easily be developed into 
full finding aids with container lists and contextual notes.  To see detailed instructions for batching records, please see MARC 
Conversion Guidelines.  
 
This document provides examples of information coded in MARC.  At the data gathering stage, it is not necessary to include 
subfields.  Some subfields are added while doing authority work and others are added when preparing the spreadsheet for 
batching.  Most of the subfields and all indicator codes are generated by MarcEdit, but certain fields require manual subfield 
entry because it is not possible to automate.  MARC 541 is an example of a field where subfields must be inserted into the text: 

541 __ $d1995 accession,$ctransferred from$aEducation Department. 
541 __ $cDonated by$aDr. Jerome G. Rozen, Jr. 

 
There are not many fields like the one above and most content can be converted using MarcEdit. 
 

The Process 
This is a 3-step process: 

 Gathering data in a spreadsheet 

 Preparing the data for MARC conversion 

 Processing data into MARC records 
 
Each stage requires quality control and review and/or reconfiguration of the data: 

 Gathering stage 
o Authority work 
o Review of data with supervisors, Head of Special Collections and Head of Cataloging 

 Preparing stage 
o Reconfigure spreadsheet to create 1:1 map of spreadsheet columns to MARC fields 

 Processing stage 
o Create multiple line entries for repeatable fields 
o Add 008 and 015 leader information 
o Final review of subfields, indicator codes and punctuation before uploading into catalog  
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This document supports the data gathering stage and gives examples of MARC configurations.  Spreadsheet reconfiguration 
should be performed or supervised by the Project Archivists.   Instructions for preparing spreadsheets will be included in the 
batching document, MARC Conversion Guidelines. 
 

Field-by-field guideline 

(R) = repeatable, (NR) = non-repeatable 
 

DATA FIELDS  

099 *Call Number (NR) Page 5 

1xx *Creator (NR) Page 6-7 

245 *Title (NR) Page 7-8 

245 $f *Date Inclusive (NR) Page 7-8 

245 $g Date Bulk (NR) Page 7-8 

246 Varying Form of Title (R) Page 8 

520 *Summary (R) Page 11 

300 *Physical Description (R) Page 9 

351 Arrangement (R) Page 10 

500 Notes (R) Page 10-11 

541 Immediate Source of Acquisition (R) Page 13 

544 Related Archival Materials (R) Page 13 

583 Condition (R) Page 14-15 

583 Action Note (Conservation) (R) Page 14-15 

65x *Subject—Topical, Geographic Name (R) Page 16-17 

690 †Subject—Local Topical Term (R) Page 17 

6xx Subject—Person, Corporation, Meeting (R) Page 15-16 

7xx Contributor (R) Page 18-19 

555 Finding Aid (R) Page 14 

506 *†Restrictions on Access Note (R) Page 11 

852 *†Location (R) Page 19 

949 *†Local Processing Information (R) Page 19 

 
*Required 
†Added to spreadsheet after data gathering. 

 
This is a field-by-field guideline for data input in our cataloging spreadsheets.  Each field has an equivalent MARC field or 
subfield which is indicated in a header on the spreadsheet.  Specific instructions for providing information for the different 
fields can be found using the table above.  Examples are provided along with MARC-encoded counterparts.  Data gathering 
teams are not expected to include MARC codes, but they are illustrated here to demonstrate how the information is displayed 
in MARC.   
 
This guideline is set up to define each unique field to provide some detailed explanations and examples.  The spreadsheet may 
not include all the fields described in this manual.  Some fields have been combined to streamline record-taking.  Creator, 
Subjects, Contributors are examples of fields that are combined on the spreadsheet as 1xx, 65x/6xx, and 7xx respectively.  On 
the other hand, the Title Statement is divided into three distinct fields in the spreadsheet to capture the subfields Inclusive 
Dates and Bulk Dates in different columns.  The spreadsheet is designed to allow for the most efficient way of gathering data 
while working through a large number of collections in the stacks or on location in the Science Departments.  
 
Examples for each field are given for reference.  This guideline uses sections from PACSCL’s Minimal Processing Manual, a 
document intended for creating finding aids.  The complete document can be found online at: http://clir.pacscl.org/wp-
content/uploads/2009/07/Processing-Manual_Spring-2010.pdf 
 
General notes:  
Please separate multiple entries with a “ >> ” (two right arrowheads).  This delimiter will be used to indicate a new line entry, 
rather than creating multiple columns of data. 
 

Example: 300 Physical Description  |  2 boxes (1 linear foot) >> 15 negatives >> 1 map 

http://clir.pacscl.org/wp-content/uploads/2009/07/Processing-Manual_Spring-2010.pdf
http://clir.pacscl.org/wp-content/uploads/2009/07/Processing-Manual_Spring-2010.pdf
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Authority work can be done after the data has been captured from the materials.  When copying MARC authorities from the 
OPAC or Library of Congress (LoC), leave the subfields in place.  For more information on authority work, see Authority 
procedures. 
 

Example: Carter, T. Donald|q(Thomas Donald),|d1893-1972. 

 
If an authority cannot be found, please indicate them as “uncontrolled”.  
 

Example: Stone, Byron S. (uncontrolled) 
 
The information provided here has been customized and edited for use with the AMNH Library practices.  For complete 
definitions of MARC fields, see OCLC Bibliographic Formats and Standards (http://www.oclc.org/bibformats/en/) and Library of 
Congress MARC 21 for Bibliographic data (http://www.loc.gov/marc/bibliographic/). 
 
As this is a working document, revisions and enhancements will be made over the course of the project.  If you have any 
suggestions or requests for clarification, please email Iris Lee at ilee@amnh.org 
 

http://www.oclc.org/bibformats/en/
http://www.loc.gov/marc/bibliographic/
mailto:ilee@amnh.org
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Call Number 
099 Local Free-Text Call Number (NR) 

REQUIRED 

Call number assigned to collection. 
 
Examples 
MSS .C375 
DR 001 
DR 002-004 

MARC indicators  
1st Indicator: blank 
2nd Indicator: blank 
 
MARC subfields 
$a Classification Number (NR) 
 
MARC Examples 
099  __ $aMSS$a.C375 
099  __ $aDR$a001 
099  __ $aDR$a002-004 

 
The call number is a unique identifier assigned to an archival collection.  Data sets cataloged for the CLIR grant use a prefix plus 
cutter numbers or sequential numbers: 

 Manuscripts – MSS + cutter number 

 Department Records – DR + sequential number 

 Photographic Print Collection – PPC + cutter number 

 Photographic Slide Collection – PSC + sequential number 
 
Call numbers using cutters are formed by using the prefix followed by a period and the cutter number.  Sequential numbers are 
not divided by a period. 
 
Occasionally collections overlap in content and purpose.  Rather than creating individual records, they are cataloged as a single 
collection with a call number such as DR 002-004, which contains DR 002, DR 003, and DR 004.  
 
On the other hand, collections may need to be broken down into more discrete units to effectively catalog the material.  In this 
case sequential numbers may be followed by a suffix, such as DR 001A, DR 001B, etc.  Ideally the collections that share the 
same base number are related to one another.  Suffixes are added when the next numeric call number is not available.  Please 
consult with your supervisor before making decisions to combine or separate collections. 
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Creator: Personal Name 
100 Main Entry – Personal Name (NR) 

REQUIRED – main entry can be 100, 110, 111, or Title (as main entry) 

Person responsible for the creation of the collection. 
 
Examples 
Reeds, Chester A. (Chester Albert), b. 1882. 

Dyer, Walter Gurnee, photographer. 

MARC indicators  
1st Indicator: 0=Forename, 1=Surname, 3=Family Name 
2nd Indicator: blank 
 
MARC subfields 
$a Personal name (NR) 
$b Numeration (NR) 
$c Titles and other words associated with the name (R) 
$d Dates associated with a name (NR) 
$e Relator term/Role (R) 
$q Fuller form of name (NR) 
 
MARC Examples 
100  1_ $aReeds, Chester A.$q(Chester Albert),$db. 1882. 
100  1_ $a Dyer, Walter Gurnee, $ephotographer. 

 

Creator: Corporate Name 
110 Main Entry – Corporate Name (NR) 

REQUIRED – main entry can be 100, 110, 111, or Title (as main entry) 

Organization/Institution responsible for the creation of the 
collection. 
 
Examples 
American Museum of Natural History. Dept. of Education. 
 
 

MARC indicators  
1st Indicator: 0=Inverted name, 1=Jurisdiction, 2=Name in 
direct order 
2nd Indicator: blank 
 
MARC subfields 
$a Organization/Institution name (NR) 
$b Subordinate unit (R) 
 
MARC Examples 
110  2_ $aAmerican Museum of Natural History.$bDept. of 
Education. 

 

Creator: Meeting Name 
111 Main Entry – Meeting Name (NR) 

REQUIRED – main entry can be 100, 110, 111, or Title (as main entry) 

Event, such as an expedition, responsible for the creation of 
the collection. 
 
Examples 
American Museum Congo Expedition (1909-1915) 

World's Columbian Exposition (1893 : Chicago, Ill.) 

MARC indicators  
1st Indicator: 0=Inverted name, 1=Jurisdiction, 2=Name in 
direct order 
2nd Indicator: blank 
 
MARC subfields 
$a Meeting name (NR) 
$c Location of meeting (NR) 
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$d Date of meeting (R) 
$e Name of a subordinate unit entered under meeting name 
(R) 
$q Name of meeting following jurisdiction name entry 
element (R) 
 
MARC Examples 
111  2_ $aAmerican Museum Congo Expedition$d(1909-1915) 
111 2_ $aWorld's Columbian Exposition$d(1893 :$cChicago, 
Ill.) 

 
Record one entity for the main entry of a collection.  Additional creator(s) can be listed in the 7xx field(s).   
 
MARC Note: Subfield $d Date of meeting comes before $c Location of meeting as in the example above for the World’s 
Columbian Exposition. 
 

 

Title (including Inclusive Date and Bulk Date) 
245 Title Statement (NR) 

REQUIRED 

DACS compliant title for the collection.  Record inclusive dates 
as a date range to indicate the beginning and end of record 
creation.  Record bulk dates to describe the dominant period 
of date(s), if any.  Precede the year(s) with “bulk”. 
 
Examples 
State Appropriations, 1884-1886. 

Grapevine newsletters, 1942-1992 (bulk 1942-1966, 1983-

1992). 

T. Donald Carter field books, 1910-1972. 

Afghan Expedition of the American Museum of Natural 

History field photographs, 1950-1951. 

Wesley Lanyon photographic slide collection, undated. 

MARC indicators  
1st Indicator: 0=No added entry, 1=Title added entry 
2nd Indicator: 0=No nonfiling characters, 1-9=Number of 
nonfiling characters present 
 
MARC subfields 
$a Title (NR) 
$f  Inclusive dates (NR) 
$g Bulk dates (NR) 
 
MARC Examples 
245 10 $aState Appropriations,$f1884-1886 
245 10 $aGrapevine newsletters,$f1942-1992$g(bulk 1942-
1966, 1983-1992) 

 
Titles and inclusive dates are required.  Supplied titles generally have two parts: the name of the creator(s) or collector(s) and 
the nature of the materials being described.  If you are unsure of the dates or do not wish to be misleading, use “undated.”  
Bulk dates are not required.  If the date range cannot be determined without further examination of records, use “circa” or an 
estimated date.   
 
MARC Note: Indicate Title as an added entry except when it is the main entry.  Validation errors occur in Connexion when there 
is no 100/110/111 entity associated with the record.   
 
To form DACS compliant dates, see below for further guidelines (modified from PACSCL’s Minimal Processing Manual). 

 Inclusive Dates: 
o Use this: 1849-1851 (no spaces around the dash) 
o NOT 1849-51 

 If the collection continues to accrue, place the most recent accrual in the date span: 
o 1965-<2012> 
o (NOT 1965- OR 1965- (Ongoing) 

 Bulk Dates: 
o 1785-1960, bulk 1916-1958 
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 Significant Gap in Records: 
o 1827, 1952-1978 

 Estimated Date Ranges: 
o circa 1870-1879 

 Single Dates: 
o 1975 OR 1975 March-August OR 1906 March 17 

 Estimated Single Dates: 
o probably 1867 
o approximately 1867 
o before 1867 
o after 1867 January 5 
o 1867 or 1868 
o 1860s 
o circa August 1975 

 
Punctuation note:  Do not include periods at the end of title statements or dates.  Terminal periods will be placed later when 
the spreadsheet is converted to MARC. 
 
 

Varying Form of Title 
246 Varying Form of Title (R) 

OPTIONAL 

Use for DACS-compliant titles that are otherwise too long 
when indicating the creator. 
 
Examples 
American Museum of Natural History Department of 
Education booklets and pamphlets 

American Museum of Natural History Grapevine newsletters 

MARC indicators  
1st Indicator: 2=No note no added entry 
2nd Indicator: 3=Other title 
 
MARC subfields 
$a Title statement (NR) 
 
MARC Examples 
246 23 $aAmerican Museum of Natural History Department 
of Education booklets and pamphlets 
246 23 $aAmerican Museum of Natural History Grapevine 
newsletters 

 
Use Varying Form of Title for collections with names that are unnecessarily long in order to be compliant with DACS.  If a title 
can stand alone on its own without the redundant use of the creator name, make an additional entry for the title in the 246 
field.  This is will be used for the EAD record.  
 

Example: (110) American Museum of Natural History. Dept. of Education. 
(245) Department of Education booklets and pamphlets, 1918-1968. 

 (246) American Museum of Natural History Department of Education booklets and pamphlets 
 
DO NOT use for titles such as: 
 (100) Carter, T. Donald (Thomas Donald), 1893-1972. 
 (245) Collection, 1910-1970. 
 
This is not a stand-alone title and should be (245) T. Donald Carter collection, 1910-1970. 
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Physical Description 
300 Physical Description (R) 

REQUIRED 

Record boxes and linear feet in parentheses. Calculate linear 
feet to the nearest 0.25.  
 
If possible, quantify various formats.  
 
Examples 
5 boxes (3 linear feet) 

70 photographs 

15 maps 

8 sound cassettes 

12 slides 
 

MARC indicators  
1st Indicator: blank 
2nd Indicator: blank 
 
MARC subfields 
$a Extent (R) 
$b Other physical details (NR) 
$c Dimension (NR) 
$f Type of unit (R) 
$g Size of unit (R) 
$3 Materials specified (NR) 
 
MARC Examples 
300 __ $a5 boxes (3 linear feet) 
300 __ $a 70 photographs 
300 __ $a 15 maps 
300 __ $a 8 sound cassettes 
300 __ $a 12 slides 
 

 
Quantify the number of boxes and linear feet as a parallel statement in parentheses.  Quantifying formats is not required, but 
will help in Phase 2 of the project.  Material descriptions should be taken from a standard thesaurus.  Below is a short list of 
formats from LoC Thesaurus for Graphic Materials (http://www.loc.gov/pictures/collection/tgm/).  Please refer to the website 
for a comprehensive list.   

 maps 

 floorplans 

 photographs 

 stereographs 

 negatives 

 film negatives 

 nitrate negatives 

 slides 

 transparencies 

 lantern slides 

 digital prints 

 videodiscs (use for CDs, DVDs, or other media that is recorded by a laser and can be displayed on a video screen)
 
Other terms (taken from the Library OPAC): 

 videocassettes (type of carrier can be recorded under notes, e.g., VHS) 

 sound cassettes 
 
For terms that cannot be found in a standard thesaurus, please specify in the summary or notes field.  Do not list formats that 
cannot be enumerated.  See MARC 500, General Notes, for gathering information that states the inclusion of various formats. 
 
For the risk assessment phase of this project, specific names are provided in a drop-down menu of “collection units.”  These 
terms are specific to the risk assessment data analysis and should not be used for descriptive cataloging.  Following the 
completion of cataloging and risk assessment, information from the Access database may be integrated into the cataloging 
spreadsheets where collection unit terms will be replaced with their corresponding format designations. 
 
 

http://www.loc.gov/pictures/collection/tgm/
http://www.loc.gov/pictures/item/tgm006261/
http://www.loc.gov/pictures/collection/tgm/item/tgm004131/
http://www.loc.gov/pictures/collection/tgm/item/tgm007721/
http://www.loc.gov/pictures/collection/tgm/item/tgm010140/
http://www.loc.gov/pictures/collection/tgm/item/tgm007029/
http://www.loc.gov/pictures/collection/tgm/item/tgm003973/
http://www.loc.gov/pictures/collection/tgm/item/tgm007089/
http://www.loc.gov/pictures/collection/tgm/item/tgm009731/
http://www.loc.gov/pictures/collection/tgm/item/tgm011013/
http://www.loc.gov/pictures/collection/tgm/item/tgm005803/
http://www.loc.gov/pictures/item/tgm003080/
http://www.loc.gov/pictures/collection/tgm/item/tgm011359/
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Arrangement 
351 Organization and Arrangement of Materials (R) 

OPTIONAL 

Pattern of arrangement for materials within a unit. e.g., 
alphabetical, chronological, by country, by office of origin, etc.   
 
Also indicate subdivisions of collections that have been 
combined into a larger unit.  See the last example below. 
 
Examples 
Folders in boxes arranged alphabetically. 

Arranged in folders by Dr. James Atz. 

Reports for 1958-1961 in 1 vol.; reports for 1969, 1970 and 
1972 in 2 vols. each year. 

Organized into two groups: 085. Minutes of the Council of the 
Scientific Staff, 1936-1943. 086. Minutes and records of the 
Council of the Scientific Staff, 1912-1998.  

MARC indicators  
1st Indicator: blank 
2nd Indicator: blank 
 
MARC subfields 
$a Organization (R) 
$b Arrangement (R) 
$c Hierarchical level (NR) 
$3 Materials (NR) 
 
MARC Examples 
351 __  $3Folders in boxes $barranged alphabetically. 
351 __  $bArranged in folders by Dr. James Atz. 
351 __  $3Reports for 1958-1961 in 1 vol.; reports for 1969, 
1970 and 1972 in$a2 vols. each year.    
351 __  $aOrganized into two groups: 085. Minutes of the 
Council of the Scientific Staff, 1936-1943. 086. Minutes and 
records of the Council of the Scientific Staff, 1912-1998.  

 
Use this field to describe how the material is arranged.  This is a useful field for collections that are combined due to an overlap 
of content.  Groups can be further broken down with their individual collection numbers preceding the content description.  In 
the last example shown above, The Minutes of the Scientific Staff was cataloged as one record: DR 085-086.  The discrete 
collections that make up DR 085-086 are further broken down by the notation of the original call number followed by a period 
and the title/contents: 085. Minutes of the Coucil…  
 
 

Notes 
500 General Note (R) 

OPTIONAL 

General notes. Please state Includes field notes for collections 
that contain field notes. 
 
Examples 
Includes field notes. 

Includes duplicates within collection. 

Includes photographs and blueprints.  

Unprocessed collection. 

MARC indicators  
1st Indicator: blank 
2nd Indicator: blank 
 
MARC subfields 
$a General note (NR) 
$3 Materials specified (NR) 
 
MARC Examples 
500 __  $aIncludes field notes. 
500 __  $aIncludes duplicates within collection. 
500 __  $aIncludes photographs and blueprints. 
500 __ $aUnprocessed collection. 
500 __ $aPrevious number used: USDE 938 

 
Use this field to indicate field notes, physical formats that cannot be quantified, and unprocessed collections among other 
general notes.  This field is repeatable and statements can be separated by “>>” in the spreadsheet to specify a new line item. 
End individual statements with a terminal period. 
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Example: Includes field notes. >> Includes duplicates within collection. >> Unprocessed collection. 
 

Also use the Notes field to record call numbers that have significance to the collection.  This number can help identify the 
collection in additional inventories.  Historical numbers may have been used in citations or previous numbers used may 
reference supporting documentation in the Library, therefore important to document. 
 
 

Restrictions on Access Note 
506  Restrictions on Access Note (R) 

REQUIRED 

Globally populated with information from the department. 
 
Examples 
Please contact Special Collections; materials are sometimes 
restricted. 

MARC indicators  
1st Indicator: blank=Undefined, 0=No restrictions, 
1=Restrictions apply 
2nd Indicator: blank 
 
MARC subfields 
$a  Terms governing access (NR) 
 
MARC Examples 
506 __ $aPlease contact Special Collections; materials are 
sometimes restricted. 

 
This field is added to the spreadsheet after the data has been gathered but before converting into MARC records.  Different 
AMNH Department archives may have specific restrictions.  The language should be reviewed by Barbara Mathé and the 
collection managers.  The example above reflects the main Research Library’s restriction note. 
 
 

Summary 
520 Summary, Etc. (R) 

REQUIRED 

Scope and general content notes. Briefly describe the 
content: Who or what is the collection about? What is 
contained in the collection? Include the most important 
keywords. Use complete sentences.  
 
Start the summary with the word "Field notes" if the 
collection consists entirely of field notes.  If the collection 
contains field notes, please include a descriptive summary of 
them.  
 
Examples 
Correspondence to and from Dr. Jerome G. Rozen. Some 
material related to the Southwestern Research Station and 
Archold Expeditions. 

Field notes from Frank E. Watson, the first steward of 
Lepidoptera at American Museum of Natural History. Field 
notes begin in 1896 and end in 1947, the time of Watson's 
death. Concerned chiefly with butterflies collecting in the 
West Indies and northeastern United States. Also included are 
field notes from Fred Rindge, insect collecting expedition 

MARC indicators  
1st Indicator: 2=Scope and content, 3=Abstract 
2nd Indicator: Undefined 
 
MARC subfields 
$a Summary, etc (R) 
$b Expansion of summary note (NR) 
 
MARC Examples 
520 3_ $a Correspondence to and from Dr. Jerome G. Rozen. 
Some material related to the Southwestern Research Station 
and Archold Expeditions. 
520 3_ $a Field notes from Frank E. Watson, the first steward 
of Lepidoptera at American Museum of Natural History. Field 
notes begin in 1896 and end in 1947, the time of Watson's 
death. Concerned chiefly with butterflies collecting in the 
West Indies and northeastern United States. Also included are 
field notes from Fred Rindge, insect collecting expedition 
(primarily in the United States) from 1955 to 1970. Papers, 
records, notebooks, metal index card container and research 
of the Department of Entomology. Contains freak monarch 
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(primarily in the United States) from 1955 to 1970. Papers, 
records, notebooks, metal index card container and research 
of the Department of Entomology. Contains freak monarch 
butterfly with two wings, framed in display case. Also includes 
many notebooks and loose papers describing various insect 
species. 

butterfly with two wings, framed in display case. Also includes 
many notebooks and loose papers describing various insect 
species. 

 
Though not required in standard MARC record, it is one of our required minimal level cataloging elements.  Describe the 
contents of the collection briefly in at least 1-2 sentences as an Abstract.  For full finding aids, the Scope and Contents Note is 
developed more fully and includes contextual information about the resources being described.  Please refer to the Scope and 
Contents Note guidelines below to help create a succinct statement for the Abstract. 
 
Below are guidelines for writing the Abstract and Scope and Contents Notes (from PACSCL’s Minimal Processing Manual). 
 
Abstract 

 The abstract is a brief and tidy statement that sums up the collection  

 It is useful for providing researchers with the most essential facts about the collection. 

 You should describe the collection in just a few sentences: 

 Who or what is the collection about? 

 What is contained in the collection? 

 Include the most important keywords 
 
Scope and Contents Note 

 This note is about the contents of the collection.  

 This is a place to discuss highlights, obvious gaps in records, or unique perspectives on the topic of the collection.  

 In every scope note, the following should be included:  
o Types of materials found in the collection (genres or documentary forms) such as minutes, diaries, reports, 

water colors, documentaries, etc. Specifics can be added:  
 Example: Included in the collection are diaries describing day-to-day activities as well as nationally 

important events such as the signing of the Constitution of the United States of America in 1787 
and Philadelphia‘s Yellow Fever Epidemic in 1793.  

o Main Subjects (use your best judgment).  
o All Series Titles and Subseries Titles, if applicable.  
o Areas of the collection which are particularly rich with information.  
o Dates  

 Spans of the records, dates of events, or extremely important time frames within the creators life 
or business operations:  

 Example: If you are referring to Picasso‘s Blue Period, note the dates: 1900-1904.  
 Formats  

 In narratives, use normal date order such as July 22, 2009.  

 When describing a span, do not use spaces around the hyphen: 1945-1947 and do not 
abbreviate: NOT 1945-47. However, ―from 1800 to 1900‖ is preferred.  

 Decades are written without an apostrophe: 1920s.  
o Functions or activities resulting in the creation of the records.  
o How the collection fits into the more general context of history.  
o How the collection may be useful to researchers (this is really the highlights section).  

 Example: Researchers interested in colonial medicine may find the diaries which include entries 
on treating yellow fever to be useful.  

 
A Scope and Contents Note worksheet is included in the full PACSCL manual. 
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Immediate Source of Acquistion 
541 Immediate Source of Acquisition Note (R) 

OPTIONAL 

Provenance of the collection. 
 
Examples 
1990 accession. 

1995 accession, transferred from Education Department. 

Donated by Dr. Jerome G. Rozen, Jr. 

 

MARC indicators  
1st Indicator: Leave blank

1
 

2nd Indicator: blank 
 
MARC subfields 
$a Source of acquisition (NR) 
$c Method of acquisition (NR) 
$d Date of acquisition (NR) 
 
MARC Examples 
541 __ $d1990 accession. 
541 __ $d1995 accession,$ctransferred from$aEducation 
Department. 
541 __ $cDonated by$aDr. Jerome G. Rozen, Jr. 

 
Take information from direct sources such as acquisition sheets, descriptions marked on the box label, or from the documents 
themselves.  The Library may have documents in the vertical files located in Special Collections (for archives housed in the Main 
Library).  Ask your supervisor if there is more information regarding a collection’s acquisition.   
 
 

Related Archival Materials 
544 Location of Other Archival Materials Note (R) 

OPTIONAL 

Reference to related archival materials and collections. List 
call numbers, accession numbers, or locations where material 
can be found. 
 
Examples 
Archival material relating to the Hayden Planetarium is 
available in the planetarium's archives, housed in the AMNH 
Library Special Collections on the 7th floor. 

Related material can be found in Henry Fairfield Osborn 
papers, 1877-1935 (bulk 1908-1935); call number: MSS .O835. 

MARC indicators  
1st Indicator: 0=Associated materials, 1=Related materials 
2nd Indicator: blank 
 
MARC subfields 
$n Note (R)  
 
MARC Examples 
544 1_ $nArchival material relating to the Hayden 
Planetarium is available in the planetarium's archives, housed 
in the AMNH Library Special Collections on the 7th floor. 
544 1_ $n Related material can be found in Henry Fairfield 
Osborn papers, 1877-1935 (bulk 1908-1935); call number: 
MSS .O835. 

 
As we move through the projects gathering descriptions, this has become an increasingly important field.  Locating related 
materials, especially when they are housed in different locations, may reestablish provenance to collections that have been 
long since separated as the museum departments evolved over time.  Communicate with your supervisor and fellow interns 
about collections that may be related.  This is an area that could warrant extra research. 
 

                                                           
1 MarcEdit has a MARC validator that performs quality control on the converted records.  Using an indicator in this field will result in an error. 
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Finding Aid 
555  Cumulative Index/Finding Aids Note (R) 

OPTIONAL 

Indicate if a finding aid or container list is available. If EAD 
exists, please provide the URL.   
 
Examples 
Container list filed with collection. Container list needs to be 
updated. 

Hard copy of finding aid filed with collection. 
 

MARC indicators  
1st Indicator: blank=Indexes, 0=Finding aids 
2nd Indicator: blank 
 
MARC subfields 
$a Cumulative index/finding aids note (NR) 
$u Uniform Resource Identifier (R) 
 
MARC Examples 
555  0_ $aContainer list filed with collection. Container list 
needs to be updated. 
555  0_ $aHard copy of finding aid filed with collection. 

 
Some of the collections may include hard copies of finding aids, container lists, or other resource description made to help 
people locate contents.  Use this field to note if such aids are available.  Unprocessed collections should be noted in the 500 
General Notes field.  
 
 

Condition (including Action Note) 
583 Action Note (R) 

OPTIONAL 

Choose from drop-down menu: Good, Fair, Poor. 
 
In Action Note field, describe conservation issues and/or 
preservation actions. 
 
Examples 
Condition: good 

Condition: good 
Action Note: floor plans housed in a cardboard box, could be 
placed in archival boxes; oversize blueprints are folded; 
manuscript box needs a spacer, papers caving 

MARC indicators  
1st Indicator: Leave blank 
2nd Indicator: blank 
 
MARC subfields 
$a Action (NR) (mandatory) 
$c Time/date of action (R) -- YYYYMMDD 
$l Status (R) 
 
MARC Examples 
583 __  $acondition reviewed$c20110519$lgood 
583 __  $acondition reviewed$c20110519$lgood$lfloor plans 
housed in cardboard box, could be placed In archival 
boxes;$loversize blueprints are folded;$lmanuscript box 
needs a spacer, papers caving 

 
The information recorded in the cataloging phase will also be merged with the LARA database for the risk assessment phase.  
Note any conditions that can be useful to assess risk to different formats.  Separate action notes with a semicolon (;).  
 
After the risk assessment phase, the information gathered in the LARA databases may be carried over into the Excel 
spreadsheets before data conversion.  For now this step is done by project supervisors. 
 
MARC Note: The information provided gets transformed to follow the appropriate conventions.  This is done after the data is 
gathered but before the spreadsheets are converted.  Subfields and dates are added using a simple Find+Replace.  For example, 
the dropdown menu item, “Good” becomes “$acondition reviewed$c20110519$lgood”.  The dates recorded reflect the last day 
of the term.  Also information in this field is all lowercase with no terminal punctuation; all the status notes are separated by a 
semicolon followed by the repeatable $l subfield to indicate the results of the condition during this assessment. 
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Risk Assessment Note: In general, we are not tasked with rehousing or taking action when gathering this data.  However if you 
think you have a nitrate negative on your hands, please notify your supervisor immediately.  The Library has cold storage for 
them and they should be removed from the collection with a separation sheet. 
 
 

Subject: Personal Name 
600  Subject Added Entry–Personal Name (R) 

OPTIONAL 

Person identified as a subject of the collection. 
 
Examples 
Carter, T. Donald, 1893-1972. 
 
Note: 
Separate repeatable entries with >> 
 

MARC indicators  
1st Indicator: 0=Forename, 1=Surname, 3=Family Name 
2nd Indicator: 0=Library of Congress subject heading 
 
MARC subfields 
$a Personal name (NR) 
$b Numeration (NR) 
$c Titles and other words associated with the name (R) 
$d Dates associated with a name (NR) 
$e Relator term/Role (R) 
$q Fuller form of name (NR) 
 
MARC Examples 
600 10 $aCarter, T. Donald$q(Thomas Donald),$d1893-1972. 

 

Subject: Corporate Name 
610  Subject Added Entry–Corporate Name (R) 

OPTIONAL 

Organization identified as a subject of the collection. As 
necessary, list subdivision in the same line. 
 
Examples 
American Museum of Natural History. Southwestern Research 
Station. 
 
Note: 
Separate repeatable entries with >> 
 

MARC indicators  
1st Indicator: 1=Jurisdiction, 2=Name in direct order 
2nd Indicator: 0=Library of Congress subject heading 
 
MARC subfields 
$a Organization name (NR) 
$b Subordinate unit (R) 
 
MARC Examples 
610 20 $aAmerican Museum of Natural 
History.$bSouthwestern Research Station. 

 



AMNH, Minimal-Level Cataloging Guidelines  

Page 16 

 

Subject: Meeting Name 
611  Subject Added Entry–Meeting Name (R) 

OPTIONAL 

Expedition or event identified as a subject of the collection. 
 
Examples 
Crocker Land Expedition (1913-1917) 
 
Note: 
Separate repeatable entries with >> 
 

MARC indicators  
1st Indicator: 2=Expedition name 
2nd Indicator: 0=Library of Congress subject heading 
 
MARC subfields 
$a Meeting name (NR) 
$c Location of meeting (NR) 
$d Date of meeting (R) 
$e Name of a subordinate unit entered under meeting name 
(R) 
$q Name of meeting following jurisdiction name entry 
element (R) 
 
MARC Examples 
611 20 $aCrocker Land Expedition$d(1913-1917) 

 
List people, corporations, or expeditions in which the collection is about.  It is not incorrect to repeat the creator of the 
collection as the subject.  Use LoC Name Authorites. 
 
 

Subject: Topical Term 
650 Subject Added Entry–Topical Term (R) 

REQUIRED* 

Use Library of Congress Subject Headings or subject terms in 
the AMNH Library OPAC. 
 
Examples 
Natural history museums--New York (State)--New York. 

Museum techniques--Periodicals.  

Museums--Administration--Periodicals. 

Natural history museums--Periodicals. 
 
Note: 
Separate repeatable entries with >> 
 
Museums—Administration--Periodicals.  >>  Natural history 
museums--Periodicals. 
 

MARC indicators  
1st Indicator: blank 
2nd Indicator: 0=Library of Congress subject heading, 
4=Source not specified 
 
MARC subfields 
$a  Topical term (NR) 
$x  General subdivision (R) 
$v Form subdivision (R) 
$y  Chronological subdivision (R)  
$z  Geographical subdivision (R)  
 
MARC Examples 
650 _0 $aNatural history museums$zNew York (State)$zNew 
York. 
650 _0 $aMuseum techniques$vPeriodicals.  
650 _0 $aMuseums$xAdministration$vPeriodicals.  
650 _0 $aNatural history museums$vPeriodicals. 

 
Use the Library catalog for subject headings (http://libcat.amnh.org/).  Chances are there will be subject terms and subject 
strings describing very similar holdings that you can use in the spreadsheets.  If the subject term cannot be found in the OPAC 
or the LoC authority (http://authorities.loc.gov/), record it in the provided field 6xx, Subject, Uncontrolled term.   These will be 
reviewed by the Project Archivists, along with the Head Cataloger to determine if the term will be added to our authorties or be 
listed as a 690 Local Subject Added Entry.  Authority work can be done after the information has been gathered. 

http://libcat.amnh.org/
http://authorities.loc.gov/
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*NOTE: Please include at least one 65x subject.  It can be a topical term or geographic term.  Recommended approach: search 
the OPAC for a name or expedition represented in the collection.  Often a published work or similar holding can be found with 
related subjects in the catalog record. 
 
 

Subject: Geographic Name 
651 Subject Added Entry–Geographic Name (R) 

OPTIONAL 

Use Library of Congress Subject Headings or subject terms in 
the AMNH Library OPAC. 
 
Examples 
Canada. 
Connecticut--Guidebooks. 
 
Note: 
Separate repeatable entries with >> 
 

MARC indicators  
1st Indicator: blank 
2nd Indicator: 0=Library of Congress subject heading, 
4=Source not specified 
 
MARC subfields 
$a Geographic Name (R)  
$x General subdivision (R) 
$v Form subdivision (R) 
 
MARC Examples 
651 _0 $aCanada. 
651 _0 $a Connecticut$vGuidebooks. 

 
Use the Library catalog (http://libcat.amnh.org/) and LoC authorities (http://authorities.loc.gov/) for the correct form of 
geographic terms.  Geographic terms can be further subdivided to describe the contents in more detail. 
 
 

Subject: Local Topical Term 
690  Local Subject Added Entry–Topical Term (R) 

OPTIONAL 

Use for keywords.  Some may be LCSH but not expressed in a 
hierarchical string. 
 
Examples 
Museum finance. 

Museum construction. 

Employee activities. 

Human resources. 
 
Note: 
Separate repeatable entries with >> 
 

MARC indicators  
1st Indicator: Level of subject (leave undefined) 
2nd Indicator: Leave undefined 
 
MARC subfields 
$a Uncontrolled term (R)  
 
MARC Examples 
690 __ $aMuseum finance. 
690 __ $aMuseum construction. 
690 __ $aEmployee activities. 
690 __ $aHuman resources. 

 
Local topical terms may be determined by review of supervisors and Head Cataloger, Diana Shih.  This field is added (if needed) 
by the Project Archivists during the preparation stage.  
 
 

 

http://libcat.amnh.org/
http://authorities.loc.gov/


AMNH, Minimal-Level Cataloging Guidelines  

Page 18 

Contributor: Personal Name 
700  Added Entry–Personal Name (R) 

OPTIONAL 

Use for co-creators or contributors to the collection. 
 
Examples 
Bourke-White, Margaret, 1904-1971. 
 
Note: 
Separate repeatable entries with >> 
 

MARC indicators  
1st Indicator: 0=Forename, 1=Surname, 3=Family Name 
2nd Indicator: 2=Analytical entry 
 
MARC subfields 
$a Personal name (NR) 
$b Numeration (NR) 
$c Titles and other words associated with the name (R) 
$d Dates associated with a name (NR) 
$e Relator term/Role (R) 
$q Fuller form of name (NR) 
 
MARC Examples 
700 1_ $aBourke-White, Margaret,$d1904-1971. 

 

Contributor: Corporate Name 
710  Added Entry–Corporate Name (R) 

OPTIONAL 

Use for organizations identified as co-creators or contributors 
to the collection. As necessary, list subdivision in the same 
line. 
 
Examples 
American Museum of Natural History. Trustees. 
 
Note: 
Separate repeatable entries with >> 

MARC indicators  
1st Indicator: 1=Jurisdiction, 2=Name in direct order 
2nd Indicator: 2=Analytical entry 
 
MARC subfields 
$a Organization name (NR) 
$b Subordinate unit (R) 
 
MARC Examples 
710 2_ $aAmerican Museum of Natural History.$bTrustees. 

 

Contributor: Meeting Name 
711  Added Entry–Meeting Name (R) 

OPTIONAL 

Use for expeditions or events identified as contributing 
entities to the collection. 
 
Examples 
Jesup North Pacific Expedition (1897-1903) 
 
Note: 
Separate repeatable entries with >> 
 

MARC indicators  
1st Indicator: 2=Name in direct order 
2nd Indicator: 2=Analytical entry 
 
MARC subfields 
$a Meeting name (NR) 
$c Location of meeting (NR) 
$d Date of meeting (R) 
$e Name of a subordinate unit entered under meeting name 
(R) 
$q Name of meeting following jurisdiction name entry 
element (R) 
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MARC Examples 
711 2_ $aJesup North Pacific Expedition$d(1897-1903) 

 
Contributors are additional creators for the contents of the collection.  In EAD, you can express more than one creator.  In 
MARC, the 1xx field is not repeatable and we include the other entities in 7xx.  Do not confuse the 6xx field with 7xx – this is 
specifically used for people, corporations, or expeditions responsible for creating the material that make up the collection.  
 
 

Location 
852  Location (R) 

REQUIRED 

Globally populated: OCLC institution code and AMNH 
location/department name. 
 
Examples 
NNMNH Research Library, Special Collections 
 
Note: NNMNH = OCLC institution code 

MARC indicators  
1st Indicator: blank=No information provided 
2nd Indicator: blank=No information provided 
 
MARC subfields 
$a Location (NR) 
$b Sublocation (R) 
 
MARC Examples 
852  __ $aNNMNH$bResearch Library, Special Collections 

 
This field is added to the spreadsheet before converting into MARC records.  The institution code NNMNH should be included 
for all AMNH Department archives locations. 
 
 

Processing Information 
949  Local Processing Information (R) 

REQUIRED 

Globally populated: a string of code to identify local holdings. 
 
Code 
*ov=.b;bn=speco;i=/loc=speco/ty=5/v=; 

MARC indicators locally defined 
1st Indicator: blank 
2nd Indicator: blank 
 
MARC subfields 
$a-$z locally defined 
 
MARC Examples 
949  __ $a*ov=.b;bn=speco;i=/loc=speco/ty=5/v=; 

 
This field is added to the spreadsheet before converting into MARC records.  The code may differ from one AMNH Department 
location to another.  Consult with Diana Shih. 
 

OCLC RECORD NOTE: When revising MARC records, do not re-export an OCLC record.  It will create new items in 
the catalog.  Instead, update MARC records in Millenium if the changes are minor. 
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Authority Procedures 
Version 2, 3/14/2012 

Authority work: 

 Pull name authorities from AMNH OPAC: http://libcat.amnh.org/ 

 Find a record with the data you need 

 Select MARC display 
 

 
 

 Then copy and paste the authority record with the subfields intact.  
 

 
 

 Change the color of the text to green to indicate authority work has been done. 
 

http://libcat.amnh.org/


For names that are not in the OPAC: 
1. Use Library of Congress authorities: http://id.loc.gov/ 

2. OCLC’s Virtual International Authority File (VIAF): viaf.org 

3. Vertical file spreadsheets located on the server: 

M:\Special Collections\AMNH ARCHIVE PROJECT\Cataloging Spreadsheets\Authorities 

4. If you cannot find or verify the name, leave it in the spreadsheet and add “(uncontrolled)” after 

the name 

SUBJECTS 

 Please use the Library OPAC and LCSH for authorized subject terms 

 You can cut and paste from the MARC view as illustrated above 
 
DACS 

 Titles 

 Dates 

 Check other fields if you have time 
 
GENERAL 

 Spellcheck and use correct grammar 

 Use full sentences in the Summary 

 Be consistent with character spacing (e.g., spaces between a period and the first letter of a new 
sentence) 

 Make sure multiple line entries are separated with two right arrows >> in order to facilitate 
batching. For instance, you would use this in a repeatable field such as Subject, where you may 
include 2 or more headings. Examples: 

o (650) Mammals. >> Extinct mammals. 
o (300) 5 boxes (3 linear feet) >> 10 photographs >> 3 maps 

 If you cannot finish authority work, leave a detailed report with your supervisor regarding the 
work left 

http://id.loc.gov/
http://viaf.org/
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AMNH Research Library 
MARC Conversion Guidelines 
Revised 1-12-2013 
 
 

General Notes 
These are the guidelines to the second and third steps in creating MARC records for the AMNH Library online catalog and 
WorldCat. The first step was gathering data into spreadsheets which includes authority work and data clean up. Next is 
preparing the spreadsheet for MARC conversion. The third and final stage is processing data into MARC records using MarcEdit 
and OCLC Connexion. 
 
This document provides step-by-step procedures to be used as recommended guidelines for spreadsheet preparation for MARC 
conversion. Please keep in mind there may be alternative ways to achieve the same result.  
 
You will need: 

 MS Excel 2010 

 MarcEdit (open-source MARC editor developed by Terry Reese): 
http://people.oregonstate.edu/~reeset/marcedit/html/downloads.html 

 OCLC Connexion (logon credentials required) 
 
 

Review of the Process 
This is a 3-step process: 

 Gathering data in a spreadsheet 

 Preparing the data for MARC conversion 

 Processing data into MARC records 
 
Each stage requires quality control and review and/or reconfiguration of the data: 

 Gathering stage 
o Authority work 
o Review of data with supervisors, Head of Special Collections and Head of Cataloging 

 Preparing stage 
o Reconfigure spreadsheet to create 1:1 map of spreadsheet columns to MARC fields 

 Processing stage 
o Create multiple line entries for repeatable fields 
o Add 008 and 015 leader information 
o Final review of subfields, indicator codes and punctuation before uploading into catalog  

 
Guidelines for data gathering can be found online:  
http://images.library.amnh.org/hiddencollections/wp-content/uploads/2011/11/min-cat-guidelines-MARC6.pdf 
 

Preparing the spreadsheet 
Once the records have been approved by the Science Collection Managers and AMNH Archivist, the spreadsheet data can be 
reconfigured to facilitate MARC conversion.  For this project a number of changes must be made to the general layout of the 
spreadsheet which will be covered in detail. This is the  time to add subfield codes to MARC fields such as Creator (1XX), Call 
Number (099), Subjects (6XX), Contributors (7XX), Condition (583), and Immediate Source of Acquisition (541). There are ways 
to automate the insertion of subfield codes into the data, however some fields require manual revision. 
 
 

Processing and batch-converting spreadsheet data into MARC 
The better you can prepare the spreadsheet, the cleaner the conversion into MARC.  MarcEdit has several tools to automate 
editing, which I will not go into here.  For the purposes of expediting catalog creation of minimal-level records, all heavy editing 
is done using Excel. 
 
 
  

http://people.oregonstate.edu/~reeset/marcedit/html/downloads.html
http://images.library.amnh.org/hiddencollections/wp-content/uploads/2011/11/min-cat-guidelines-MARC6.pdf


Preparing the spreadsheet 
 
SETTING UP THE  WORKING EXCEL FILE 
 

1. Create a copy of the cataloging spreadsheet: 
a. Save a version of the approved and final spreadsheet for batching.  For example, I replaced “CAT” to 

“BATCH” in the title: BATCH-Slides_db.  It is important to keep a clean master record (“CAT”) of the 
spreadsheet for other uses. 

2. Delete unnecessary columns containing notes from supervisors and the “Side Notes” column.   
3. Delete all header columns leaving only the MARC code header and the catalog data. 
4. Suggestion: color code headers to identify fields that require modification 

a. Purple = add subfield codes (099, 1XX, 541, 583, 65X, 6XX, 7XX) 
b. Blue = fields added to the spreadsheet after gathering descriptive data (852, 506, 949) 
c. Grey = leave data as is 

 
Additional columns (blue) should have the following information; all are required for MARC records: 
 

Field Name Code Content 

Location (R) 852 NNMNH $b Research Library, Special Collections 

Restrictions on Access Note (R) 506 Please contact Special Collections; materials are sometimes restricted. 

Local Processing Information (NR)
1
 949 *ov=.b;bn=speco;i=/loc=speco/ty=5/v=; 

 
Below is a screenshot of a working “BATCH” spreadsheet with some coded headers. 
 

 
 
Note: If you have any records to skip for more review, this is the time to delete them.  Also delete any unnecessary records, 
e.g., merged records. Master spreadsheet files with these records should be saved with a different name.  Remember, this is a 
working file to create MARC records. 
 
 

                                                           
1 Not technically required for MARC, but required for local uses.  The Local Processing Information identifies the holding information in the 
Millenium catalog and represents availability of the collection in the Library, Special Collections. This may change for other Science Department 
locations. 



GENERAL DATA CLEAN-UP (AACR2-COMPLIANT) AND ADDING MARC SUBFIELD CODES  
 
Global checklist: Punctuation 

 Title (245) should NOT end with a period 

Note: terminal periods will be added through MarcEdit 

 Bulk Dates (245 $g) should be enclosed in parenthesis.  

Example: (bulk 1992-1993) 

 Physical Description (300) should NOT end with a period 

Example: 1 box (0.25 linear feet) 

Example: 12 slides 

 Conservation Note (583) should be all lowercase, statements separated with a semicolon, no period at the end 

Example: slide 79-57 has three puncture holes in the film; some slides have reddish hue 

Add subfields to the (purple) columns 
Make sure authorized names and subject headings have appropriate subfields and punctuation.  Ideally this work will have 
been completed already.  Do a thorough review of the subject (65X, 690) fields to make sure the headings are in the correct 
columns: topical, geographic location, local subject, etc. 
 

Field subfield code(s) Where Example 

099 $a  Between acronym and unique call number PSC $a 10 

541 $a, $c, $d Refer to minimal-cataloging guidelines for more detail $c Donated by $a Chantal Boulanger, $d 
May 1990. 

583 $c, $l 
(subfield ‘el’) 

Run a Find+Replace to modify condition statement 
Dates are formatted as yyymmdd 

condition reviewed $c 20110826 $l good 

583 $l 
(subfield ‘el’) 

Each additional note should be preceded with $l.  
Semicolon is added to the first statement to separate 
the general condition note from the detailed 
description. 

;$lsleeve is warping due to the weight of 
the slides 

 
Separate data from 1XX, 6XX, and 7XX fields 
For ease of gathering data, main entries, entity subjects, and contributors were added to a single column respectively with the 
corresponding attribute of “Personal”, “Corporate” or “Meeting” names.  These now have to be divided into separate columns: 
100, 110, 111, 600, 610, 611, 700, 710 and 711.  
 
Note: Excel 2010 required for use of filters.  
 
These steps detail separating columns for the 1XX field, but should be repeated for 6XX and 7XX 

1. Select, copy and paste the entire 1XX column 
2. Rename one of the headers “100” 
3. Open up the Data tab in Excel and click Filter 
4. Open the filter options for the 100/110/111 column and select “Personal”.  Now only rows of data containing 

“Personal” in this particular column will be displayed. 
5. Clear contents of personal names in the original 1XX column.  Leave the new “100” column for now.   

Note: It is important that you use the “Clear contents” function rather than the “Delete” function.  Deleting cells in 
Excel can shift the data into different rows, destroying the alignment of the catalog entry! 

6. Open the filter options again for the 100/110/111 column and select “Corporate” and “Meeting” 
7. Clear contents of entries in the new 100 column 
8. Click Filter in the Data tab to deselect this view.  The 100 column should now only contain personal names and the 

original 1XX column should contain only corporate and meeting names. 
9. Repeat these steps 1-8 for “Corporate” with the new column heading titled 110.  
10. For the remaining meeting names, simply rename the 1XX column to 111. 
11. Review the data to make sure there are no repeating names in the new columns created.   

ONLY when you are confident each column is representing the correct information and no information was 
accidentally repeated or deleted, complete the final step: 

12. Delete the entire 100/110/111 column (containing the drop-down information). 
 
Pay close attention: Though each catalog record is represented by ONE main entry, a single record may have SEVERAL entity 
subjects and contributors, or SEVERAL OF BOTH.  Be very careful when clearing contents in the 6XX and 7XX fields – DO NOT 
ACCIDENTALLY DELETE ALL THE DATA DISPLAYED IN THE FILTERED VIEW!  These names can be relevant to the record and 



should remain.  If you think you may have wholesale deleted data without first checking the content (as I have the misfortune 
of knowing firsthand), undo your actions until you are back to a good starting point. 
 
Below are screenshot examples for separating the 1XX column. 
 
Data > Filter mode for Personal / Corporate / Meeting name drop-down column 
 

 
 
  



Filtered view for Personal names.  Clear contents of personal names in the original 1XX column. Do not delete cells with data. 
 

 
 

 
 
  

Remember to select  

Clear contents, NOT 

Delete 



For subject and contributor fields that contain more than one type of entity, the information will have to be parsed out one by 
one into their correct columns.  
 

 
 
COMBINING CELLS IN EXCEL 
Some cells are more easily joined in Excel than in MarcEdit. While MarcEdit does allow you to join and split cells through the 
Text Delimited Translator, the tool which converts the xls file into mrk, the results were not what I had expected.  These next 
steps show you how to combine multiple cells, such as 245 and 583, into one representative data cell for each catalog record.  It 
uses multiple steps to add subfields to data and combine the sum of the parts.  If you are familiar with combining cells, you may 
want to skip the detailed steps. 
 
General Note: Make sure your new cells are formatted as “General”.  Some columns may be specified as text, particularly the 
ones that contain numbers.  You can select the column, right-click and choose Format cells to change this. 
 
Combining 245 fields 

1. Insert a new column to the left of 245 $f (inclusive dates) 
2. In the first blank cell of this new column, type “, $f ” 

Note: the comma is added to join with the end of the title statement in 245 later. 
3. Fill down “, $f ” 
4. Insert a new column to the right of 245 $f (inclusive dates) 
5. In the first blank cell of this new column, enter the function code “=[click on first cell showing value: “, $f ”]&[click on 

first cell showing the value for inclusive date]” 
6. Hit enter.  
7. Fill down function.  The cells should populate with the data from the 2 columns. 

Note: Additionally I also copy and paste this data again as VALUES to delete the function.  This should leave you with 
solid values in the cells rather than a string of cell coordinates. 

8. Delete the “, $f ” and 245 $f columns. 
9. Manually add “$g” before any bulk dates.  Usually there are not to many so it is faster to spot check and add the 

subfield  
10. Insert a new column to the right of 245 $g (bulk dates) 
11. In the first blank cell, enter “=” then click on the cells to be joined: 245 title statement, 245 $f (combined) & 245 $g 
12. Hit enter and fill down.  Also copy and paste column as values – recommended! 
13. Delete 245 title statement, 245 $f (combined) & 245 $g columns. 

 

Cut & paste Audubon 

to 600 field 



Use function codes to join cell values 
 

 
 
Copy and paste this data again as VALUES to delete the function  
 

 
 

FUNCTION VALUE 



 
 
 
Modifying 583 data and combining 583 fields 

1. Select the 583 drop-down column and run a Find+Replace Good/Fair/Poor with the following: 
 

Find Replace 

Good condition reviewed $c [XXXXXXXX] $l good 

Fair condition reviewed $c [XXXXXXXX] $l fair 

Poor condition reviewed $c [XXXXXXXX] $l poor 

  
 [XXXXXXXX] = date of review as yyyymmdd (year-month-day) 
 

2. In the second 583 (condition note) field, add $l (subfield ‘el’) before each condition description.  Depending on the 
volume of data in this field, you may want to add the subfields manually or automate insertion by combining cells or 
running a Find+Replace. 

3. Insert a new column to the right of 583 (condition note) 
4. In the first blank cell of this new column, enter the equation “=” followed by the two 583 columns separated by “&” 
5. Hit enter.  
6. Fill down equation. 
7. Copy and paste column as Values 
8. Delete original 583 columns. 
9. Additionally, data that includes further description of the condition should also be preceded by a semi-colon.  Judge 

the volume of data to consider filling it in automatically.  The field should read something like this (with the semi-
colon in red): “condition reviewed $c 20110826 $l good; $l some slides are individually sleeved in plastic” 

 
  

VALUE VALUE 



Find+Replace “Good” with “condition reviewed $c [XXXXXXXX] $l good” 
 

 
 
After combining the two 583 fields, copy & paste the data as VALUES to delete the function 
 

 
 
  



Add a semi-colon to data that includes further description of the condition: “…good; $l…” 
 

 
 
  



Renaming Excel headers In preparation for MarcEdit 
This is an optional step, but will be incredibly useful when mapping spreadsheet data to MARC in MarcEdit.  The chart below 
provides the necessary information if you plan to move ahead to conversion.  
 
Rename the header fields in Excel using the following table.  For more detailed information about subfield codes and indicators, 
please see the data gathering draft (http://images.library.amnh.org/hiddencollections/wp-content/uploads/2011/11/min-cat-
guidelines-MARC6.pdf) or visit the OCLC bibliographic formats and standards page on the internet: 
http://www.oclc.org/bibformats/en/ 
 

Code Code for 
MarcEdit 

Field Name Notes 

099 099 $a \\ Call No.  

084 500 $a \\ Historical  
Call No. 

No longer being used in MARC records. Change to 500 with the preceding note – 
“Previous number(s) used:” 

100 100 $a 1\ Creator, 
Personal Name 

 

110 110 $a 2\ Creator, 
Corporate Name 

 

111 111 $a 2\ Creator, 
Meeting Name 

 

245 245 $a 10 
term period 

Title Add the terminal period; after conversion, update the 2
nd

 indicator for non-filing 
characters. 
Change: Titles as main entries to 245 $a 00 

246 246 $a 23 Alt Form of Title  

520 520 $a 3\ Summary  

300 300 $a \\ Physical 
Description 

 

351 351 $9 \\ Arrangement $9 is a placeholder, MarcEdit requires you input a subfield; can be deleted later. 

500 500 $a \\ Notes  

541 541 $9 \\ Source of 
Acquisition 

$9 is a placeholder, MarcEdit requires you input a subfield; can be deleted later. 

544 544 $n 1\ Related Archival 
Materials 

 

583 583 $a \\ Action Note  

651 651 $a \0 Subject, Geo 
Name 

 

650 650 $a \0 Subject, Topical  

600 600 $a 10 Subject, 
Personal Name 

 

610 610 $a 20 
review 

Subject, 
Corporate Name 

2
nd

 indicator (source of name authority) may need to be reviewed – check against 
the OPAC 

700 700 $a 1\ Contributor, 
Personal Name 

 

710 710 $a 2\ Contributor, 
Corporate Name 

 

711 711 $a 2\ Contributor, 
Meeting Name 

 

555 555 $a 0\ Finding Aid  

852 852 $a \\ Location  

506 506 $a \\ Restrictions on 
Access 

 

949 949 $9 \\ Local Processing 
Information 

$9 is a placeholder, MarcEdit requires you input a subfield; can be deleted later. 

 
 

  

http://images.library.amnh.org/hiddencollections/wp-content/uploads/2011/11/min-cat-guidelines-MARC6.pdf
http://images.library.amnh.org/hiddencollections/wp-content/uploads/2011/11/min-cat-guidelines-MARC6.pdf
http://images.library.amnh.org/hiddencollections/wp-content/uploads/2011/11/min-cat-guidelines-MARC6.pdf
http://images.library.amnh.org/hiddencollections/wp-content/uploads/2011/11/min-cat-guidelines-MARC6.pdf
http://images.library.amnh.org/hiddencollections/wp-content/uploads/2011/11/min-cat-guidelines-MARC6.pdf
http://www.oclc.org/bibformats/en/


Processing and batch-converting spreadsheet data into MARC 
 
MARCEDIT 
 
Delimited Text Translator 
The Delimited Text Translator converts delimited text files into MARC.  It allows you to define MARC fields and indicators to 
individual fields.  It also creates minimal Leader information, which you can revise.  
 

1. Launch MarcEdit (version 5.8 current) 
2. Go to Add-ins > Delimited Text Translator 
3. Navigate to the working BATCH .xslx and assign a folder to output the conversion – an editable Marc text  file (.mrk) 
4. Make sure to include the name of the sheet in your Excel spreadsheet 
5. Check the UTF-8 encoded box (optional) 
6. Click Edit LDR/008 and consult the charts listed further in this guideline 

 

 
 

 
 
 
 
  



Leader chart 
Byte summary can be found at http://www.oclc.org/bibformats/en/fixedfield/008summary.shtm 
 

Data set suggested LEADER  (examples) 
(REVIEW  in Connexion) 

Manuscripts 00000ntca 2200000Ia 4500 

Department Records 00000npca 2200265Ka 4500 

Photo Slides 00000ngca 2200373Ka 4500 

Photo Prints 00000nkm  2200253Ka 4500 

 
008 breakdown 
Must contain 40 characters total.  MARC file will not validate otherwise. 
 
General Example: 
 

x x x x x x x x x x x x x x x n y u \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ x x e n g \ d 

 

 Character space Value 

 1-6 Date entered as yymmdd, supplied by system 

 7 DtSt, variable code referencing date (See 008 chart below) 

 8-15 Start date and end date; for unknown digits, use "u" 

 16-18 Country code, which is "nyu" for New York, United States 

 19-33 Use backslash for blanks 

 34 Tmat, type of material; see list of codes. "s" for slides is an example 

 35 Tech, technique (for moving images); use "n" for not applicable 

 36-38 Language code; "eng" for English 

 39 Use backslash for blank 

 40 Src, Cataloging source; use "d" for other 

 
Example for Slides:  
x x x x x x x x x x x x x x x n y u \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ s n e n g \ d 
 
Example for DR:  
x x x x x x x x x x x x x x x n y u \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ \ e n g \ d 
 
008 DtSt chart 
Detailed descriptions can be found at http://www.oclc.org/bibformats/en/fixedfield/dtst.shtm 
 

type code record data (example) 008 data (example) 

single date (use for circa dates) s 1991 or circa 1990s s1991\\\\ or s199u\\\\ 

inclusive dates (use for circa dates) i 1960-1969 or circa 1950-1970 i19601969 or i195u197u 

undated n undated nuuuuuuuu 

bulk dates k bulk 1990s k199u199u 

detailed date e January 1999 e199901uu 

exact single date e April 29, 1993 e19930429 

 
 
  

http://www.oclc.org/bibformats/en/fixedfield/008summary.shtm
http://www.oclc.org/bibformats/en/fixedfield/dtst.shtm


Mapping fields to MARC in Delimited Text Translator 
When your spreadsheet has loaded, a window will appear to assign MARC fields to spreadsheet data.  You can either refer to 
the previous chart listing codes for MarcEdit, or if you have renamed your spreadsheet headers, use them as guides.   
 
Some things to keep in mind: 

 Field numbers in the “Select” box must be highlighted to apply the code 

 There is no space between the MARC field and subfield 

 Backslashes indicate a blank entry 

 The displayed spreadsheet headers can be expanded 

 But DO NOT CLICK INSIDE THE DATA FIELDS THAT RUN ACROSS THE TOP – THEY WILL DISAPPEAR AND YOU WILL 
HAVE TO START THE PROCESS ALL OVER! 

 Click Apply to assign the definition, click Finish when you’re done 
 
Some good things to know: 

 Under “Arguments” you will see the definitions load.  You can join or split arguments by selecting and right-clicking 
for more options.  I have personally not had much luck with this functionality but it is available. 

 You can save and apply templates.  This can be extremely useful for absolutely consistent header formations.  For 
different spreadsheets generated from different data sets or Science locations, it is likely that there will be some 
variation in data organization. 

 

  
 
  

You can expand the column width 

to view information but do not 

click in the data fields! 



Editing the MARC records as text 
After applying all the definitions in the Delimited Text Translator, the resulting MARC text file looks like this: 
 

 
 
You can edit this document as text.  Using this file you will want to make the following revisions: 

 008 - Insert correct date information for each record 

 Create new line entries for data following a >> 
Example: in the above screenshot the last line displays 4 separate subject headings for 650.  Delete “>>” and add new 
line “=650  \0$aPotlatch $z British Columbia.”  Repeat for the remaining subjects. 

 Review indicator codes for 245 and 610 

 Delete all instances of $9 

 Make sure long entries have not been truncated (this can often happen in 520 with long descriptions of content) 

 Delete the first record displaying your mapping definitions 
 
Note: Editing shortcuts such as Copy, Paste and Find+Replace are available in this mode. 
 
Validate the file 
Go to Tools > Validate MARC Records 
Run the validator and fix any errors that result 
 
  



Convert the MARC text file (.mrk) to a MARC (.mrc) file 

 In the main view, go to Tools > MarkMaker 

 Select your input file and choose your output file location 

 Select MarcMaker under Functions 

 Click Execute 

 Your resulting (.mrc) file will have a purple icon 
 

 
 

 
 
 
OCLC CONNEXION 
 
Batch importing .mrc file into OCLC Connextion 

 Launch Connexion and logon.  You will need credentials to upload and export holdings, i.e. publish records. 

 Go to File > Import records and navigate to the .mrc file (purple icon)  

 Import to local save file (or online if preferred) 

 Click OK 



 If successful you will get a result page.  If you have problems, check the Options and make sure you set your 
Maximum Number of Matches to Download to 150

2
. 

Tools > Options > Batch tab 
 
File > Import records 
 

 
 
Successful import result page! 
 

 
 
  

                                                           
2 OCLC Connexion offers a batchload service for a fee. The batchload setup would cost $338, with no per-record charge (quoted 6/28/2011). 
Additional batchloads could be processed at no additional cost as long as they are sent under the same project and use the same type of 
conversion. Link to an order checklist: http://www.oclc.org/us/en/support/documentation/batchprocessing/using/checklistfororderingBib.pdf 
 
You can import a maximum of 150 records at a time without the use of OCLC’s batchload service. The advantage being there is no additional 
cost, however the disadvantage is the spreadsheet data must be converted to .mrc using the steps detailed here. It is a question of time vs. 
cost, and how much control of the data conversion is desired. OCLC will convert an .xls file. Here we are using MarcEdit to do the .xls 
conversions. 

http://www.oclc.org/us/en/support/documentation/batchprocessing/using/checklistfororderingBib.pdf


Change the Maximum Number of Matches to Download to 150 if you have problems importing. 
Tools > Options > Batch tab 
 

 
 
  



Edit, Upload and Export MARC records for WorldCat and Library OPAC 
In Connexion, you will have a final chance to review your records before publishing to WorldCat and the Library catalog.  You 
can also link controlled terms and revise Leader and 008 information if necessary. 
 

1. Show records: Cataloging > Show > By Local Save File Status (or online) 
2. Open a new record to edit 
3. Right-click control headings for names, subjects and contributors.  Select Control Single Heading 
4. Do one final review of the content 
5. Upload to WorldCat: Update holdings (F8) 
6. Export to Millenium: Export (F5) 

 
Note: Validation errors may occur.  Records that do not validate will not publish.  If you encounter an error, refer to the OCLC 
bibliographic formats and standards website (http://www.oclc.org/bibformats/en/) to help resolve the problem, or consult 
Diana Shih. 
 
Show records 
 

  
 
Control Single Headings.  Links to OCLC’s authority records. 
 

 
  

http://www.oclc.org/bibformats/en/


Unqualified names will prompt a window like the one below.  You can click on the name to see more details about the person. 
Once you confirm that this is the correct individual, click on Insert Heading. 
 

 
 
 
EXTERNAL DOCUMENTATION 
 
All records for CLIR that have been batched are indexed in a spreadsheet report with the date published, call number, OCLC 
number, and other relevant information.  This is not a necessary step, but done for the purposes of grant documentation.   
The file is called: RecordsPublished_2011-2012 
filepath: M:\Special Collections\AMNH ARCHIVE PROJECT\CLIR\Reports\Batch 
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Finding Aid Guidelines 
Revised 1-12-2013 
 
Getting started 
Before you begin arranging and describing the collection, you will want to become familiar with what 
you have.  Information for the collection can be found in several forms.  Most immediate is the material 
itself, but because we do not have the time or resources to look at every single item contained in the 
collection, there are other sources of information that may offer useful data:  

 Box labels 

 Folder labels 

 Catalog record or inventory 

 Accession records 

 Provenance sheets 

 Container lists 

 Vertical files (located in Special Collections) 
 
Some collections are cataloged and a print out of the record might be with the collection.  You can 
search the AMNH Research Library Online Public Access Catalog (OPAC) using the local call number 
search option.  Open http://libcat.amnh.org/ in your browser then choose Local call number in the drop 
down menu.   
 
Accession records, provenance sheets, and container lists may also be included in hard copy with the 
collection if they are available.  Use these records to build a context and a framework for the material 
you have.  Use these records as starting points.  Later you may find some data to be updated, such as 
dates and extent. 
 
Make notes of any relevant information you will want to include in your collection descriptions: personal 
and corporate names, dates, fields of study, expeditions, department names, etc.     
 
Examining records and minimal processing 
The collections we will be working with this semester are fairly well organized and may have gone 
through a first pass of processing.  We will not be removing staples or paperclips and in general, very 
light processing such as refoldering and rehousing into archival boxes.  Please see page 4 of the PACSL 
manual to see some action we may take for various situations. 
 
While examining the records, look for information that may be relevant to a researcher.  A collection of 
T. Donald Carter field notebooks may have dates, geographic locations, expedition names, and 
specimens acquired/studied.  Take note of these in the provided worksheet or on a separate sheet of 
paper.  You may also want to make note of gaps in dates, physical formats included, and conservation 
issues present. 
 
As much as possible, leave the material in their original order.  Society of American Archivists (SAA) 
defines original order as “The organization and sequence of records established by the creator of the 
records.”  Maintaining that sequence may provide important insight as to how the creator used those 
records.  However a haphazard structure is not helpful to a researcher and can be difficult to describe.  If 
you feel strongly that a collection needs rearranging, please consult with Iris or Barbara.  
   

http://libcat.amnh.org/


Below is the full note regarding original order by SAA: 
 

Original order is a fundamental principle of archives. Maintaining records in original order serves two purposes. First, 
it preserves existing relationships and evidential significance that can be inferred from the context of the records. 
Second, it exploits the record creator's mechanisms to access the records, saving the archives the work of creating 
new access tools. 
 
Original order is not the same as the order in which materials were received. Items that were clearly misfiled may be 
refiled in their proper location. Materials may have had their original order disturbed, often during inactive use, 
before transfer to the archives; see restoration of original order. 
 
A collection may not have meaningful order if the creator stored items in a haphazard fashion. In such instances, 
archivists often impose order on the materials to facilitate arrangement and description. The principle of respect for 
original order does not extend to respect for original chaos.

1
 

 
Finding Aid components 
Please follow the links to the section in the Finding Aid Template for more instructions. 

 Title Page 

 Collection Information 

 Repository 

 Collection 
o Creator 
o Inclusive Dates 
o Bulk Dates 
o Call Number 
o Extent 
o Physical Description 
o Condition 
o Prepared by/Date 

 Biographical Sketch 

 Historical Note 

 Scope and Content 

 Separated Material (if applicable) 

 Related Material (if applicable) 

 Access Conditions and Restrictions 

 Custodial History 

 Preferred Citation 

 Source of Acquisition 

 Subjects 

 Container List 
o Series Title (if applicable) 
o Box Number 
o Folder Number 
o Folder Title 

 

                                                           
1
 Pearce-Moses, Richard. SAA: A Glossary of Archival and Records Terminology. 

http://www.archivists.org/glossary/term_details.asp?DefinitionKey=69 (Accessed September 14, 2011). 

http://www.archivists.org/glossary/term_details.asp?DefinitionKey=69


Finding Aid Worksheet 

CALL NUMBER 
 Number:   OPAC record      

  Existing inventory   

EXTENT 
Record number of  

boxes and linear feet. 

Beginning of processing: 
 

End of processing: 

CREATOR 
Record the entity responsible for 

the collection. 

 

TITLE  

DATES 
Make any notes for  

bulk or missing dates. 

 

PERSONAL NAMES 
Other persons responsible for the 

contents of the collection. 

 

CORPORATE NAMES 
Other agencies responsible for 
the contents of the collection. 

 

PHYSICAL DESCRIPTION 
Various formats included in the 

collection. If it is a small amount, 
please quantify: 10 photographs. 

 

CONDITION 
Briefly describe the condition 

 

CONSERVATION 
Describe needs for conservation, 

if any.  

 

SUBJECTS 
These can include fields of study, 

expedition names, topical 
headings, etc. 

 

RELATED MATERIAL  

SEPARATED MATERIAL  

SERIES? 
 

 

SENSITIVE MATERIAL? 
 

 



Call Number: XXX XXX 

 

 

 

 

 

 

 

 

TITLE 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

American Museum of Natural History 

Special Collections-Library 

Central Park West at 79th Street 

New York, NY 10024 

 

 

 



COLLECTION INFORMATION 

 

Repository:  

American Museum of Natural History, Special Collections-Library 

Central Park West at 79th Street 

New York, NY 10024 

 

Collection: The title of the collection 

 

Creator: The name of the person who made the collection. If you can, look them up in the catalog 

and use the authority name. 

Example: Bean, Thomas E. (Thomas Ebenezer), 1844-1931 

 

Inclusive Dates: 1879-1934 

Bulk Dates: 1892-1930 

How to Format Strange Dates: 

 There’s a significant gap in the records: 1827, 1952-1963 

 Not sure about the exact dates: approximately 1952-1978 or approximately 1897 

 Just one exact date: 1906 August 17 

 Can just pin it down to the month/months: 1975 August or 1978 March-August 

 No earthly idea about the date: undated 

 

Call Number: 

 

Extent: You will probably have both the number of boxes and the number of linear feet. Do not 

abbreviate either ‘linear feet’ or the type of box.  

Example: .25 linear feet (1 box), 50 linear feet (34 boxes, 1 box of catalog cards) 

 

Physical Description: Provide information about any important physical characteristics that 

affect the use of the collection (i.e. media [handwritten notes, photographs]) 

 

Condition: Fragile, etc.  

 

Prepared by/Date: Your Name, Month and Year 

 

Revised by/Date:  

 

  



BIOGRAPHICAL SKETCH 

Include the following items if applicable. For a more guided worksheet, please refer to 

the PACSL manual, page 12. 

 Genealogy 

 Historical Background 

 Chronology 

 

HISTORICAL NOTE 

For a more guided worksheet, please refer to the PACSL manual, page 13. 

 

SCOPE AND CONTENT 

Identify the subject matter and the form of the collection to enable users to judge its 

potential relevance. Highlight any other information about the collection that would useful to the 

researcher. For a more guided worksheet, please refer to the PACSL manual, page 14. 

 

SEPARATED MATERIAL 

Information about materials that are associated by provenance to the described materials 

but that have been physically separated or removed. 

 

RELATED MATERIAL 

Information about materials that are not physically or logically included in the material 

described in the finding aid but that may be of use to a reader because of an association to the 

described materials. Materials designated by this element are not related to the described material 

by provenance, accumulation, or use.  Include a brief summary and call number(s). 

 

ACCESS CONDITIONS AND RESTRICTIONS 

• Restrictions pertinent to this collection (e.g., restricted for 10 years after the death of 

individual, particular items that are rare and require direct supervision) 

• Requests to use the collection should be made in advance to the Senior Special 

Collections Librarian, who may be contacted at 212-769-5420 or at speccol@amnh.org 

 

CUSTODIAL HISTORY (if necessary) 

Provide information on changes of ownership and custody of the collection that is 

significant for its authenticity, integrity and interpretation.  

 

PREFERRED CITATION 

American Museum of Natural History, [title of collection]. 

 

SOURCE OF ACQUISITION 

e.g. Gift of Jane Smith, Interdepartmental transfer. The interesting history goes in 

Custodial History - this is just a single sentence or so that says who the archives got the 

collection from and when. 

 

 

 

 



SUBJECTS 

List topical terms related to the collection. Also include personal names, expeditions and 

organizations that are important to the collection. 

 



CONTAINER LIST 

 

Series I: Correspondence (or other series title) 

Series Description (if appropriate): This series consists of… 

 

Box Folder  Title 

1 1  [Folder title]. [Date]. 

1 2  Letter from Henry F. Osborn to Lucretia Osborn. 1930. 

2 1  Et cetera… 

 

    Series II: Clippings 

 Series Description: This series consists of clippings from various newspapers… 

 

Box Folder  Title 

13 1  [Folder title]. [Date]. 

 

 

Note: Do not use a “ to note repeated box numbers: repeat the number. Format as [box number] 

[one tab] [folder number] [two tabs] [folder title] [period] [date] [period], just like it is in the 

examples above. Whoever is encoding this later will thank you! 
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Importing finding aid container lists into  
Archivists’ Toolkit  using Excel and Notepad++ 
July 16, 2012 
 
 
General 
Use these guidelines with Excel file, AT-EAD_containerList.xlsx.  The steps will show you how to generate EAD code 
for finding aid container lists only.  Once imported into Archivists’ Toolikit, the container list can be merged with an 
existing collection-level finding aid, or can be used as a starting point for a new finding aid. 
 
You will need: 

 Excel 

 Notepad++ (open-source xml editor): http://notepad-plus-plus.org/download/v6.1.5.html 

 Archivists’ Toolkit 
and possibly an xml validator, such as oXygen to verify the EAD code.  Invalid code will not import into AT. 
 
Note: xml developer programs, like oXygen and XMetaL require a licensing fee.  oXygen offers a free 30-day trial. 
 
A basic understanding of EAD and XML is helpful.  The spreadsheet is built to expose the container list code, but it 
is not foolproof.  Careful review of tags and xml syntax is needed for a successful import. 
 
Acknowledgements: This methodology was adapted from PACSCL.  The spreadsheet was modified from Matt 
Herbison’s Excel file, Copy of EAD_data_entry-Development_version-2010aug16.  More information can be found 
on the PACSCL blog at: 
http://clir.pacscl.org/2012/03/19/excel-to-xml-the-spreadsheet-from-heaven 
 
 
Documents to use 
Copy Excel spreadsheet AT-EAD_containerList.xlsx.  You may want to rename the file as a working copy. 
It contains 3 worksheets:  

 container list code 

 copy&paste from finding aid 

 PACSCL EAD Skeleton2Copy (written by Matt Herbison) 
 

 
 
Locate and open the finding aid document you wish to import.   
 
Note: The following steps offer guidelines for finding aids written in the AMNH finding aid Word template.  If it is 
using the current template, you should be able to copy and paste the container list with little manipulation.  If not, 
a more hands-on approach to repurposing the data may be needed.   

http://notepad-plus-plus.org/download/v6.1.5.html
http://clir.pacscl.org/2012/03/19/excel-to-xml-the-spreadsheet-from-heaven
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REPURPOSING CONTAINER LISTS IN EXCEL 
Using the sheet titled copy&paste from finding aid, copy and paste the entire container list from your finding aid 
document into the cells.  Depending on how the author set up the Word document, the data may not paste 
consistently – compare and review the data carefully before moving information around (see the item circled in 
red below).  In addition, long titles may be broken up using several tabs or a hard return.  Always review and adjust 
the data to make sure that title information for each folder is represented in a single cell. 
 

 
 
Headers are provided in the spreadsheet, however you may want to create new columns or move columns to best 
work with the data you have.  The screenshot above shows descriptive summaries for the box contents.  This 
information will not be used in the conversion, but you can manually add it to the AT finding aid after the 
container list import. 
 
Break out the dates from the titles  
A quick & easy way to automate separating dates into new cells 

1. Select the column with the folder titles 
2. Use Find+Replace to add a unique delimiter to the lines 
3. Choose Data > Text to Columns. With Delimiter selected, check Other: [unique delimiter] 

 
Example: 
Chemistry notes I. 1891. 
Find = “. 1” 
Replace = “. $1” 
Use “$” as the delimiter to break the dates out of the columns 
Result: Chemistry notes I. $1891. 
 
Note: Using the period at the end of the title in the Find+Replace command keep from converting every instance of 
the number “1” into “$1”.  For instance finding “. 1” converted the line to read “Chemistry notes I. $1891” and not 
“Chemistry notes I. $189$1”.  Carefully review data to make sure other title information did not get converted by 
mistake. 
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Example using undated folders: 
Connecticut Field Note Book No. 1. undated. 
Find = “undated.” 
Replace = “$undated” 
Result: Connecticut Field Note Book No. 1. $undated. 

 
At this point, you may also want to add delimiters to parenthetical data or manually add delimiters where the 
Find+Replace did not apply.  If there are any parenthetical notes or descriptions that follow the folder titles, they 
can be added into Archivists’ Toolkit manually after the import. 
 
Data > Text to Columns 
With the title column selected, go to Data > Text to Columns 
Select Delimited 
Uncheck Tab and check Other: $ 
 

  
 
Make sure dates are in one column and notes are in another.  You may have to manually move data around to 
align in their correct columns. 
 
Create an additional column for dates 
You will need 2 columns for dates: date attribute is inserted into the code as EAD data, while date expression is 
how the date is displayed in a finding aid.  In the EAD code, the inclusive dates are written with a beginning and an 
end date with a backslash in between. e.g., “1891/1891”. 

1. Copy the entire column for dates. 
2. Insert copied column into the spreadsheet.   
3. With one column of dates selected, run a Find+Replace for hyphens (-) and replace with slashes (/).  This is 

your date attribute column. 
4. Clean up the other date column to make DACS-compliant and remove terminal periods. 

 
Notes: Single dates in the date attribute column should still be expressed by a beginning and end date.  Undated 
titles will have no data for this cell.  Be sure to include the quotation marks for the date attribute column, 
otherwise the xml will not validate.  You can add them quickly by inserting a couple of columns of quotation marks 
on either side then combining the cells; go back and remove quotation marks for undated titles. 
 
Replacing invalid characters in data 
Folder titles may include diacritics and characters that will affect the xml validation of your EAD code.  You will 
need to replace them with UTF-8 characters.  Below are a couple of examples of characters to look out for.  If 
special characters are used, you may have to manually adjust them in AT.  

 & – spell out “and” or use “&amp” instead 

 slanted quotations and apostrophes – use straight quotes and apostrophes: 
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single opening quote ‘ replace with ' 

single closing quote ’ replace with ' 

double opening quote “ replace with " 

double closing quote ” replace with " 

long dash – replace with - 

bar / pipe | replace with ; 

 
Cleaned up data ready to paste into code should look like this: 
 

 
 
 
Copying data into EAD code 
Copy and paste clean columns of data into the code template laid out in the worksheet titled container list code. 
Watch for series and folder levels – mind your <c01>s and <c02>s!  If you have a container list with series and 
subseries, pay careful attention to closing tags within nested containers.  A series should hold information for its 
constituent subseries and folders.  Its closing tags should wrap up all the elements included: </c03></c02><c01>.  
Most likely you will be working with a simple folder list which will only consist of one container element: <c01>. 
 
The columns are color-coded to give an at-a-glance view of the data that needs to be unique vs. data that can be 
repeated. 
 

grey fill down UNLESS you have a series, then match control 

white variable info, but most likely a fill down 

light blue new data from container list – use cleaned up columns from 
working sheet 

light orange closing tags – if you only have folder level (only <c01>s), then fill 
down, otherwise watch the end tags preceding a new series! 
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The very last last column is a combination (excel equation) for each line item. This is the data you will be copying 
and pasting into Notepad++ 
 

 
 
Last bits of clean up 

 Make sure you have copied and/or filled down the correct code.  Check columns that contain only “>”. 

 Delete “ normal=” from columns for titles with no dates, or marked “undated”.  Screenshot on next page. 

 Run a Find+Replace for quotations and apostrophes. 

 Do a thorough check for diacritics. 
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EXAMPLE of code for folders with no dates, or “undated” 
Remove “normal=” and leave the date attribute blank. 
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USING NOTEPAD++ 
Open a new xml file in Notepad++.  You will copy&paste two sets of information into this file: 

 The code from worksheet PACSCL EAD Skeleton2Copy 

 The column COPY+PASTE INTO NOTEPAD++ from the sheet container list code 
 
For container lists you want to merge with existing collection-level resources already in AT, you do not have to fill 
out any top-level information such as <title>, <unitid>, <unitdate>, etc.  Simply copy&paste the PACSCL skeleton 
code, then paste the new container list into the skeleton code. 
 
Save the file as an eXtensible Markup Language File (.xml) and import the EAD into Archivists’ Toolkit. 
 
 
IMPORTING INTO ARCHIVISTS’ TOOLKIT 
In the top menu options, select Import > Import EAD.  Select your new xml file and import.  The new resource 
should appear in the list (remember to select List All to view all the finding aid resources).  
 
If the file does not import, review the error message and fix the code.  Use a validator to help identify issues with 
the EAD.  Watch out for those diacritics! 
 
Merge container list with a collection-level finding aid 
Select both the collection-level finding aid and the container list and click Merge.  Select the collection-level 
resource to merge into.  This will retain all the top-level information and add the new “children” data to it.  
 
Resulting resource should look like this: 
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Workflow overview 
 Copy blank LARA db to local drive (filename: LARA Blank_db1.5) 

 Export blank database from Access into Excel 

 Review fields from Excel cataloging spreadsheet to determine data to be carried over 

 Create new Excel spreadsheet for merging fields 

 Copy and paste by column into exported Excel document 

 Copy and paste all data, including headers, into Access table (TblCollectionInfo) 

 View Access forms to verify the copied data is landing in the correct fields 
 
Note: You cannot add several new rows to an existing Access table. If new collections need to be added, 
the entire table, including headers, must be written over with updated data. However, entire columns 
may be written over. For example, Location information was added after the initial merge by copying 
and pasting the entire Division/Department/Room column. 
 
 

Step-by-step Guide for Conversion 
 
Setting up the documents 

 Copy LARA Blank_db1.5 to local drive 

 Rename the file LARA [Newname]_db1.5 

 Copy the latest CAT spreadsheet to local drive 

 Give this Excel file a temporary name – this is a working file and can be deleted at the end 
o Example: CAT-LARA Slides_db 

 
Export blank Access database to create a spreadsheet with LARA headers 
In order to merge the cataloging data, a separate Excel spreadsheet must be made with the same 
headers as the LARA database. 

 Open LARA [Newname]_db1.5 

 Open TblCollectionInfo to view collection information in table format 

 Locate External Data tab and select Excel within the category Export 

 Save file in desired location and give it a temporary name – can be deleted at the end 

o Example: LARA headers Slides_db 

 
 



 

Prepare the exported spreadsheet in Excel 
The values in the Access database can be free text, TRUE/FALSE (for check boxes), numeric percentage 
value, or data given in a drop-down list. Information pulled from the CAT spreadsheets is used to supply 
default values for the LARA databases. 

 Highlight fields that will get CAT data to easily see columns to be merged. 

 For Prints and Slides (see Appendix A and Appendix B for complete conversion tables): 
 

LARA CAT Display in Access Form   

Division/Department/Room Fill down  Location 

CallNumber Call Number Call Number 

HistoricalCallNumber Historic Call Number Historical Call Number 

Creator Creator Creator 

Title Title Title 

Date Date Inclusive Date 

NatureofMaterial  Summary, Physical 
Description, Physical 
Description: other physical 
details, Notes, Side Notes 

Summary 

SpecimenBreakdown Fill down: Individual Object Collection Unit (extent) 

SpecimenBreakdownQuantity From Physical Description Collection Unity Qty 

ConditionGood From Condition 
(TRUE/FALSE) 

Good (check box) 

ConditionFair From Condition 
(TRUE/FALSE) 

Fair (check box) 

ConditionPoor From Condition 
(TRUE/FALSE) 

Poor (check box) 

ConditionNote Action Note Condition: Note 

Cabinnetry Fill down: Open Shelving Cabinet Type 

CabinnetryOptimal Fill down: TRUE Optimal (check box) 

CabinnetryLockable Fill down: FALSE Lockable (check box) 

CabinnetryRaised Fill down: TRUE Raised (check box) 

StorageMaterialsUsedOptimal Fill down: TRUE Archival (check box) 

Preparation/LablingUnproc Finding Aid Unprocessed (check box) 

Preparation/LablingNotes From other fields pertaining 
to labeling 

Preparation/Labeling: Notes 

FieldNotes From Notes (TRUE/FALSE) Field Notes (check box) 

 
Note: Additional fields for Slides can be pre-filled, e.g., UnitName = Photographic Collections - 
color prints, negs & pos (including slides and transparencies) - Slides. Also 
StorageMaterialsUsedOptimal% = 100.00% 

 
Prepare the temporary CAT spreadsheet in Excel 
Most of the information from the cataloging spreadsheet can be copied and pasted from column to 
column between the CAT and CAT-LARA spreadsheets. The LARA summary field requires merging of 
several CAT columns. Other fields require filtering data and replacing their cell values (e.g., “Includes 
field notes.” becomes “TRUE”). Some of the preparation will be done on a case by case basis. The steps 
detailed here demonstrate one way to achieve a desired outcome. They should be used as guides. 



 

Merging several fields for NatureofMaterial  
 

1. Create a copy of the working spreadsheet into a new sheet.  
2. Delete the columns that are unnecessary for the merge. 
3. For Prints and Slides, the only columns used are:  

a. Summary 
b. Physical Description  
c. Physical Description: other physical details 
d. Notes 
e. Side Notes 

4. Insert columns in between the above fields to include a delimiter between cell 
information.  With the example above, you should have 9 working columns. 

5. Add a delimiter in the spacer column. “$” works great. Include some space for visual 
padding: “  $  “ 

6. Fill down by selecting the cells (including “  $  “) and select Fill/Down. 
7. Copy and paste the delimiter cells into the other spacer columns. 
8. Insert a new column to the end of the sheet. This will be used for merging the data 

across the rows. 
9. In the last column, create a function using this formula: 

“=A6&B6&C6&D6&E6&F6&G6&H6&I6”  
10. The results should look something like this: 

a. Field photographs of North American birds in nature, includes Cardinals, red-
shouldered hawks, and song sparrow.  $  7 slides  $  Glass mounts.  $  Includes 
field notes.  $  Includes field notes.  Authority record could not be found. 

11. Fill down by selecting the cells in that column and select Fill/Down. 
12. Insert one last column to the end of the sheet. 
13. Copy and paste the merged data column into the new column as Values (Paste Special, 

select Values). 
14. The last column will be used to copy and paste into the column with the heading 

NatureofMaterial  in the CAT-LARA Excel spreadsheet. 
 

 

 



 

Removing delimiters from cells for LARA database 
 
In the cataloging spreadsheets, delimiters may have been used to facilitate an eventual splitting 
of fields for MARC conversion. Rather than including them in the LARA Access database, they 
can be removed by a simple Find and Replace. This example uses the Call Number field. 
 

1. Select the cataloging data for Call Number. 
2. Conduct a Find and Replace to remove delimters.  

a. Find: “  ‡  “ (2 spaces before and after ‡) 
b. Replace: “ “ (single space) 

3. Review the column to change any missed delimiters. 
 

 
 

 
Massage cataloging data for LARA database in CAT-LARA Excel spreadsheet 
This is used for descriptive fields that can be transformed into values that appear in check boxes in 
Access. Only “TRUE” is needed for inserting check marks.  

 

Replacing textual data with TRUE for LARA checkboxes 
 
In an effort to save time in Phase 2, information such as Good/Fair/Poor have been translated as 
“TRUE” in the CAT-LARA spreadsheet. This places a check in the associated boxes for the Access 
database. This uses the Find and Replace for transforming data to “TRUE”. 
 

1. Select the cataloging data for Condition. 
2. Paste into the CAT-LARA spreadsheet, ConditionGood. 
3. Review the column to clean up data that does not say “Good”, “Fair”, or “Poor”. 
4. Copy and paste the clean column into ConditionFair and ConditionPoor. 
5. Select column ConditionGood. 
6. Find “Good” and Replace with “TRUE” 
7. Find “Fair” and Replace with blank. 
8. Find “Poor” and Replace with blank. 
9. Repeat for columns ConditionFair and ConditionPoor with corresponding values. 

 
Note: The Find and Replace will also transform the header column.  



 

Replacing textual data with TRUE for LARA checkboxes using Filters 
 
This action can be used for other fields that have check boxes, e.g., Field Notes.  This works well 
to display only the rows that match your search criteria in free-text fields. Excel indicates the 
rows by displaying the numbers on the far left as blue. You may also notice that the numbers 
will not follow a sequential order with the filter applied. Selections and transformations made in 
this view will only affect the filtered rows. 
 

1. Select the cataloging data for Notes. 
2. Paste into the CAT-LARA spreadsheet, FieldNotes. 
3. Apply a Filter to the column by typing “field” into the search bar. You will want to have 

(Select All Search Results) selected. 
4. Review the filtered fields to make sure they all relate to field notes. 
5. Replace the values in the first cell with “TRUE”. 
6. Select the filtered cells (will appear blue in the Excel number listed on the far left), 

including “TRUE” and Fill/Down. 
7. Deselect Filter to view all the data. 
8. Review the remaining cells and delete all data that does not equal “TRUE”. 

 

 
 

 



Copy CAT-LARA Excel cells into LARA Access Table 
After preparing all the data to be merged in Excel, copy and paste the entire sheet into the Access table. 
 

1. Open LARA [Newname]_db1.5 
2. Open the TblCollectionInfo table from the Tables panel. 
3. Copy CAT-LARA Excel sheet. 
4. Select all and paste into the blank LARA table. 
5. View Access forms to verify the copied data is landing in the correct fields. 

 

    
 

 
 
 



APPENDIX A: 
PHOTOGRAPHIC SLIDE COLLECTION, Research Library 

 
 

LARA CAT Display in Access Form   

Division/Department/Room Fill down: Research Library - 
Research Library - Neg 

Location 

UnitName Fill down: Photographic 
Collections - color prints, 
negs & pos (including slides 
and transparencies) - Slides 

Collection Unit 

CallNumber Call Number Call Number 

HistoricalCallNumber Historic Call Number Historical Call Number 

Creator Creator Creator 

Title Title Title 

Date Date Inclusive Date 

NatureofMaterial  Summary, Physical 
Description, Physical 
Description: other physical 
details, Notes, Side Notes; 
Add “Adhesive labels.” 

Summary 

SpecimenBreakdown Fill down: Individual Object Collection Unit (extent) 

SpecimenBreakdownQuantity From Physical Description Collection Unity Qty 

ActionNone Fill down: TRUE None (check box) 

ActionNone% Fill down: 100.00% None (percentage field) 

ConditionGood From Condition 
(TRUE/FALSE) 

Good (check box) 

ConditionFair From Condition 
(TRUE/FALSE) 

Fair (check box) 

ConditionPoor From Condition 
(TRUE/FALSE) 

Poor (check box) 

ConditionNote Action Note Condition: Note 

Cabinnetry Fill down: Open Shelving Cabinet Type 

CabinnetryOptimal Fill down: TRUE Optimal (check box) 

CabinnetryLockable Fill down: FALSE Lockable (check box) 

CabinnetryRaised Fill down: TRUE Raised (check box) 

StorageMaterialsUsedOptimal Fill down: TRUE Archival (check box) 

StorageMaterialsUsedOptimal% Fill down: 100.00% Archival (percentage field) 

StorageMaterialsUsedNotes Fill down: Housed in plastic 
trays. 

Storage: Notes 

Preparation/LablingNotes Filtered from Action Note Preparation/Labeling: Notes 

FieldNotes From Notes (TRUE/FALSE) Field Notes (check box) 

 



APPENDIX B: 
PHOTOGRAPHIC PRINT COLLECTION, Research Library 

 
 

LARA CAT Display in Access Form   

Division/Department/Room Fill down: Research Library - 
Research Library - 7th Floor 

Location 

UnitName Fill down: Photographic 
Collections - B/W prints, all 
processes (e.g. albumen, 
collodion, silver gelatin) 

Collection Unit 

CallNumber Call Number Call Number 

HistoricalCallNumber Historic Call Number Historical Call Number 

Creator Creator Creator 

Title Title Title 

Date Date Inclusive Date 

NatureofMaterial  Summary, Physical 
Description, Physical 
Description: other physical 
details, Notes, Side Notes 

Summary 

SpecimenBreakdown Fill down: Individual Object Collection Unit (extent) 

ActionNone Fill down: TRUE None (check box) 

ActionNone% Fill down: 100.00% None (Percentage field) 

ConditionGood From Condition 
(TRUE/FALSE) 

Good (check box) 

ConditionFair From Condition 
(TRUE/FALSE) 

Fair (check box) 

ConditionPoor From Condition 
(TRUE/FALSE) 

Poor (check box) 

ConditionNote From Condition if it was a 
value other than 
Good/Fair/Poor 

Condition: Note 

Cabinnetry Fill down: Open Shelving Cabinet Type 

CabinnetryOptimal Fill down: TRUE Optimal (check box) 

CabinnetryLockable Fill down: FALSE Lockable (check box) 

CabinnetryRaised Fill down: TRUE Raised (check box) 

StorageMaterialsUsedOptimal Fill down: TRUE Archival (check box) 

StorageMaterialsUsedOptimal% Fill down: 100.00% Archival (Percentage field) 

StorageMaterialsUsedNotes Action Note Storage: Notes 

Preparation/LablingUnproc From Finding Aid 
(TRUE/FALSE) 

Unprocessed (check box) 

Preparation/LablingNotes Fill down: Partially 
processed, in labeled 
folders. 

Preparation/Labeling: Notes 

FieldNotes From Notes (TRUE/FALSE) Field Notes (check box) 

 
 
 




